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LICENSE AGREEMENT FOR MELCO SOFTWARE

IMPORTANT READ CAREFULLY: This License Agreement is a legal agreement between you, the individual or entity using the Melco
software product ("User") and Melco Embroidery Systems ("Melco"). By installing or otherwise using this Melco software Product, User
agrees to be bound by the terms of this License Agreement. 

1. GRANT OF LICENSE. This License Agreement covers the Melco software product, contained on CD-ROM and/or disk, and accompanying
documentation and/or manuals (the "Software"), and the dongle security device (the "dongle"), all of which are referred to as the
"Product." Melco grants to User a non-exclusive, non-transferable, personal, limited license to use the Product according to the terms of
this License Agreement. User may also install the Software on a storage device, such as a network server, used only to install or run the
Software on User's other computers over an internal network; however, User must acquire and dedicate a license for each separate
computer on which the Software is installed or run from the storage device. A license for the Product may not be shared or used
concurrently on different computers. The Product is licensed for use only by User and may not be re-licensed or sub-licensed without
Melco's prior written permission. In the event that Melco grants such permission, a re-licensing fee will be charged.

2. COPYRIGHT. The Product contains proprietary information of Melco. This material is protected by copyright laws, international treaty
provisions, and other laws respecting proprietary rights. Melco retains all rights in the Product, including (without limitation) all copyright
and other proprietary rights worldwide in all media. User may not use the Product except as expressly permitted under this License
Agreement and under U.S. copyright laws. 

3. RESTRICTIONS. User may not and may not permit others to: copy, reproduce, publish, publicly display, distribute, sell, or otherwise use
any material contained in the Product in any manner whatsoever that may infringe any copyright or proprietary interest of Melco (except
that in the case of software contained on a disk, User may make one backup copy); distribute, rent, sublicense, lease, transfer, assign or in
any way commercially exploit, the Product or the License Agreement; decompile, disassemble or otherwise reverse-engineer the Product, or
alter, translate, modify or adapt the Product to create derivative works. This license can only be transferred with written permission of
Melco. This license is not a sale. Title and copyrights to the Product remain with Melco. If User breaches any provision of this License
Agreement, Melco may immediately terminate this License Agreement and all licenses granted hereunder without prior notice and in
addition to any other available rights and remedies. In such event, User shall immediately return to Melco all copies of the Software,
accompanying documentation and/or manuals, and all associated dongles that are within User's custody or control.

4. LIMITED WARRANTY. Melco warrants that the Software will perform substantially in accordance with published specifications and the
accompanying written materials provided that the Software is used on the computer hardware and with the operating system for which it
was designed, for a period of ninety (90) days. Melco does not warrant that the Software will meet the User's requirements or run without
interruption or error. 

Melco warrants, in accordance with and subject to the provisions herein contained, the dongle against defects in materials and
workmanship under normal use and service when properly installed for a period of twelve (12) months from the date of delivery to User.
This warranty does not extend to or cover the dongle or any part of it which, in the reasonable opinion of Melco, has been damaged or
rendered defective by accident, electrostatic discharge, willful act, negligence, misuse, alteration, repair, electrical fusion, or lightning.

Subject to the limitations stated above, Melco will use its best efforts to replace defective media, defective dongles, or correct significant
software error, provided that User returns the defective material to Melco Embroidery Systems, 1575 W. 124th Ave., Denver, CO 80234,
within ninety (90) days of delivery, in the case of Software, and within twelve (12) months of delivery, in the case of a dongle. This is User's
sole remedy for breach of warranty. 

5. NO OTHER WARRANTIES. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, MELCO DISCLAIMS ALL OTHER WARRANTIES,
EITHER EXPRESS OR IMPLIED, WITH REGARD TO THE PRODUCT, INCLUDING, BUT NOT LIMITED TO, IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, OR ANY OTHER WARRANTY WITH RESPECT TO THE QUALITY,
ACCURACY OR FREEDOM FROM ERROR OF THE OPERATION, USE AND FUNCTION OF THE PRODUCT. THIS LIMITED WARRANTY GIVES
YOU SPECIFIC LEGAL RIGHTS. YOU MAY HAVE OTHERS, WHICH VARY FROM STATE/JURISDICTION TO STATE/JURISDICTION.

6. NO LIABILITY FOR CONSEQUENTIAL DAMAGES. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL
MELCO BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL DAMAGES WHATSOEVER (INCLUDING, WITHOUT
LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY OTHER
PECUNIARY LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE THE PRODUCT, EVEN IF MELCO HAS BEEN ADVISED OF THE
POSSIBILITY OF SUCH DAMAGES.

7. CUSTOMER'S RESPONSIBILITY. It is the User's responsibility to verify before purchase that the Product will be suitable for User's intended
purpose(s). It is also the responsibility of the User to disclose to a potential buyer of the Product, that transfer of the Product requires the
prior written permission of Melco and that a re-licensing fee is charged by Melco for transfer of the license to another party.
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Embroidery Network System
Embroidery Network System (ENS) is a Windows  32 bit
program that allows the remote control and monitoring of
EMT and EMC type embroidery machines. Below is a
picture of the main screen in ENS.

ENS has a status bar on the bottom of the screen. In the
lower left hand corner the status bar displays the function
of the tool that you have positioned the mouse pointer over.

In the lower right hand corner the status bar displays the
letters ES. This tells the status of Ethernet “E” and StarLAN
“S” Networks. If the letter displays black, then the network
is disabled; you can enable it in the Tools Menu. When the
letter displays red, the network is on but not receiving;
when it displays green, the network is on and receiving
data.
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Minimum System Requirements
Pentium 133

16 MB of RAM

Mouse

CD ROM

SVGA (800x600 minimum)

Ethernet card and/or Melco network card

Windows 95/98/ME/NT/2000 (StarLan will not 
function under Windows NT)

25 MB of free hard drive space

Software Installation

Installing the Dongle
The dongle is a security device that must be installed in an
active parallel port of your computer.

1. Locate an active parallel port on the rear of your
computer. Usually this is LPT1, but it could be LPT2 if
you have two parallel ports.

2. Turn the computer OFF.

3. Secure the dongle with the captive screws at its sides.

ENS Installation
Microsoft Windows must be installed prior to installing
ENS. If Windows is not installed, refer to the Windows
installation manual.

1. Insert the ENS Program CD into the CD ROM drive

2. Follow the auto-run installation program instructions.

If the auto-run installation program doesn’t begin:

1. Click on Start→→Run to display the Run dialog box.

2. Browse to your CD-ROM drive.

3. Select setup.exe and click Open.
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Installing the
Dongle
If you have a
printer attached
to your parallel
port, remove the
printer cable,
attach the dongle,
then reinstall the
printer cable to
the end of the
dongle.



4. Click OK and follow the on-screen instructions to install
ENS.

ENS will install in the “Melco Apps” program group. If you
choose not to create a desktop shortcut icon, you can start
ENS by going to Start→→Programs→→Melco Apps→→ENS.

Internet Introduction 
ENS offers an online Help System that incorporates several
Internet-enabled features, but before you can use those
features you need to have an Internet account. The ENS on-
line Help System is a series of Internet Web pages.
Accessing the on-line Help does NOT require an Internet
account, but does require the use of a Web browser.
Internet Explorer is included on the ENS CD-ROM for this
purpose.

The Internet is a worldwide network of computer networks.
Often referred to as the World Wide Web (www), it is
comprised of thousands of separately administered networks
of many sizes and types. Each of these networks is
comprised of as many as tens of thousands of computers;
the total number of individual users of the Internet is in the
millions. Additionally, over 78 countries have access to the
Web, and e-mail contact is available in over 146 countries. 

Hypertext Linking 
The key to the Web is the concept of Hypertext Linking. This
is where text or graphics on one page is linked to related
text or graphics on another page. Clicking on the Hypertext
Link will connect you to that related information. 

Hypertext links appear as highlighted text. If you put your
mouse pointer over the text and click on the left button it
will take you to the related page. The other kind of
Hypertext link is a graphic link. This is where you put your
pointer on top of an icon or graphical representation and
click to go to another page. After you have clicked on a link,
if you want to go back to your last location, simply click on
your browser's Back button. 
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Configuration
After the initial
setup of ENS you
may want to go to
Properties under
the Tools Menu to
enable a type of
networking
support, if needed.
Refer to pages 29
and 30.



Setting up a Network
You can set up a network between a group of computers or
you can create a network between a group of computers and
a server. A network allows for multiple computers to share
the same information. A network also allows multiple
computers to share resources, for instance you can have
two computers hooked up to a network with several
machines. For example, one computer can be running
EDS/Design Shop software while the other computer is
running ENS.

For complete instructions on setting up a network, please
refer to the network section in your Microsoft Windows
reference manual.

EDS III Considerations
In EDS III, when the user clicks on Peripheral: Transfer or
Peripheral: Status, or Peripheral: Client Server List, EDS III
will search its .INI file for a reference to ENS. If found, EDS
III will start the ENS program. If ENS cannot be run, or if
ENS was not installed on the computer, the standard EDS
III peripheral functions will be used.

If you have EDS III, you should turn off the networking
functions in EDS III and make  a change to the EDS3.INI
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Design
Shop/EDS/ENS
computer

Design
Shop/EDS/ENS
laptop



file to properly utilize ENS networking. To do this, follow the
instructions on the next page:

Turning off networking functionality in EDS III

1. Using Internet Explorer, open the Config program in the
Melco Embroidery System Programs Folder.

2. Double click on “Hardware”.

3. Unselect “StarLan” and “Ethernet”. Click on the box next
to each. A checkmark indicates it is selected. No
checkmark indicates it is unselected.

4. Press “OK”

Updating the EDS3.INI file

1. In Windows Explorer do a search to locate EDS3.INI

2. Open the file and scroll to the end.

3. Type the following text exactly as it reads:
[ENS]
PATH=C:\PROGRA~1\MELCOE~1\EMBROI~1

4. Save and close the file.

Specific Requirements
EDS III software requires the Novell client and the IPX/SPX
protocol to be loaded in order to work with Ethernet
peripherals. The IPX frame type MUST be set to “Ethernet
802.3.” 

ENS will function with the same configuration as stated for
EDS III but, it is not necessary to set the frame type with
ENS.

ENS will also function with the Microsoft client (as installed
from the Microsoft Windows CD). The IPX/SPX protocol does
NOT need to be loaded but, either the Novell or Microsoft
client must be installed.

Embroidery Network System User Manual

32292 Rev. A Melco Embroidery Systems

6

Sharing Hard
Drives
If the Microsoft
client is loaded, it
will provide
everything that is
needed by ENS to
share hard drives
across the
network.

Important
The EDS III
dongle MUST be
placed before the
ENS dongle on the
parallel port. If the
ENS dongle is
first, EDS III will
not function.
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Quick Start
This chapter is designed to help get you up and running
quickly with your new ENS system by providing step-by-step
instructions on some frequently used tasks. To obtain more
detailed information  refer to the pertinent section in
chapter three of this manual.

Transferring Files
The two ways that you can transfer design files to selected
peripheral are by using the send option or by using the
drag-and-drop method.

Transfer Using the Send Option
1. Left click the mouse on the Transfer tab.

2. Select desired peripheral (machine) from the peripheral
list along the left side of the screen.

3. Left click the mouse on the down arrow to the right of
“Look in...”.

4. Browse for desired drive and file folder to find files.

5. Select one or more files.

a. Select one file by left clicking the desired file.

b. Select consecutive multiple files by holding down
<Shift> and clicking the first and last files.

c. Select non-consecutive multiple files by holding down
<Ctrl> and selecting each desired file.

6. Transfer by left clicking the Send button.

Transfer Using the Drag-and-Drop Method
1. Left click the mouse on the transfer tab.

2. Left click the mouse on the down arrow to the right of
“Look in...”.

3. Browse for desired drive and file folder to find files.



4. Select one or more files.

a. Select one file by left clicking the desired file.

b. Select consecutive multiple files by holding down
<Shift> and clicking the first and last files.

c. Select non-consecutive multiple files by holding down
<Ctrl> and selecting each and every desired file.

5. Left click on one of the items and continue holding
mouse button down as you drag the item to the desired
peripheral (machine), then release.

Checking Status
1. Left click the mouse on the Status tab.

2. Left click the desired peripheral (machine) from the left
side of the screen.

Deleting Designs From the Status Tab
1. You can select one or more designs to be deleted from

the list.

a. Select one design by left clicking on the design.

b. Select additional designs by left clicking on each
design.

2. Left click on the Delete button.

Saving and Resetting Statistics
1. Left click the mouse on the Statistics tab.

2. If you want to save the statistics, do so before resetting.

a. Left click the Save button.

b. A Save As screen will appear, browse for desired
location.

3. Left click the Reset button to reset all of the machine’s
counters.

4. A window will pop up asking, “Are you sure?”, left click
OK.
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Updating Statistics
The statistics shown on the screen are the peripheral data
that were current when the peripheral was selected. To
obtain more current statistics, do so by left clicking the
Update button on the Statistics tab.

Clearing Alerts
Alerts can be cleared from the Alert tab in two ways. You
can clear all of the alerts from one specific peripheral or you
can clear all of the alerts listed on the tab.

1. Left click the mouse on the Alert tab.

2. Select one or more alerts.

a. Select one alert by left clicking on the desired alert.

b. Select consecutive multiple alerts by holding down
<Shift> and clicking the first and last alerts.

c. Select non-consecutive multiple alerts by holding
down <Ctrl> and selecting each and every desired alert.

3. Now left click the clear button.

*Note: If you click the clear all button it will clear every one
of the alerts, selected or not.
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Alerts Tab 
The Alerts tab allows you to quickly review the alerts each
peripheral has received since the last time the alerts were
cleared. Below is a picture of the Alerts tab.

Alert Messages 
This list displays all alerts that your peripherals have
returned.

Clear 
This button clears a selected alert. To clear an alert, left
click one time on the alert message, then click the Clear
button. 

Clear All 
The Clear All button clears all alert messages for all
peripherals. 

Date and Time 
The date and time that are displayed here are the date and
time that the alert was received from the peripheral.
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Machine Name 
This field displays which peripheral has displayed the alert.
The alert message and time stamp are displayed on the
same line. 

Print 
Click Print to print the information found on the current
Tab.

When you print to a file, you must first select the printer
that will ultimately print the file. ENS then saves the file in
the appropriate printer language. That printer can be
connected to any kind of computer, even if ENS is not
installed. 

Show All
If the Show All box is selected and has a check mark next to
it, then the Alerts tab will display all alerts for all machines.
If the box does not have a check mark next to it, then the
Alerts tab will only display the alerts for the selected
machine. Left click Show All to select.

Other Alert Notifications
Besides the Alerts tab, you will be notified of alerts in two
other ways. The last alert will be displayed in the box
located to the left of the Alerts tab, below the peripheral list.
You can configure the notification of this box under the
Tools Menu, Properties, Alerts (see page 28).

Another type of alert occurs in the peripheral list (the
picture to the left of the machine name). When this picture
is highlighted yellow this signifies an alert that the machine
has stopped. This can occur for example when there is a
thread break, a bobbin break, or a machine error. This alert
can also occur if the machine is idle and simply waiting to
start. The cause will be displayed in the last alert when it
occurs or you can look in the alert list.
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Client/Server Tab 
The Client/Server tab allows you to quickly review the
ENS/EDS/Design Shop computers (Servers) and peripherals
(Clients) currently online. Below is a picture of the
Client/Server tab.

Peripheral (client) 

This area displays all the peripherals (or clients) that are
currently on-line. The name that is displayed for each
peripheral is the name the peripheral is configured with.
This field cannot be edited, and is shown for informational
purposes only. 

The Network and Address fields are not editable, and are
displayed for informational purposes only. Each of those
fields shows data pertinent to your network and your
network adapter(s). 

Server 
This field displays all Design Shop, EDS IV, ENS (and EDS
III version 3.10 and later) computers that are currently on-
line. The RSA column displays whether or not that server
has been designated to download RSA files. The Server

Important!
Although each
computer is
considered a
server on the
network, only one
should be
designated to
download RSA
files.
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name will appear as you have configured it under the Tools
Menu. 

Service Tab 
The Service tab allows a qualified service technician to
quickly review some of the service information stored in the
peripheral. Below is a picture of the Service tab.

Machine Meters 
The fields in this area display pertinent readings on various
electronic components in the peripheral. The colored
indicator lights that are to the right of each meter reading
indicate whether the readings are within tolerance or not.
This information may be used by a qualified service
technician to help troubleshoot any malfunctions in a
peripheral.

You can select a different peripheral by simply clicking on
that peripheral in the Peripheral List (along the left-hand
side of the screen). 

Meter Readings
A green light next
to the reading is
an indication that
the reading is
good. A red light
is an indication of
a problem. A
negative sign
indicates a low
reading and a
positive sign
indicates a high
reading.
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Times 
This area displays times for the CPU and RUN times. This
information may be used by a qualified service technician to
help troubleshoot any malfunctions in a peripheral. 

You can select a different peripheral by simply clicking on
that peripheral in the Peripheral List (along the left-hand
side of the screen). 

Update
Click this button to have the Service Information tab display
the latest readings. This applies only to Machine Meters.

Statistics Tab
The Statistics tab allows you to quickly review the statistics
for each peripheral connected to your network. Below is a
picture of the Statistics tab. 

Remember, the statistics are reset each time you turn the
power off to your peripheral, so the statistics shown have
only accumulated since the last time the peripheral was
powered up.
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Sort by stitches 
When you select this option, the number of stitches (per
head and per needle) will be displayed. You can choose to
display the stitches either by job or by day. Remember, the
statistics are reset each time you turn the power on to your
peripheral, so the Total option will only display the stitches
sewn since the last time the peripheral was powered up. 

Sort by stitches per break 
When you select this option, the number of stitches per
thread break (per head and per needle) will be displayed.
You can choose to display the stitches per thread break
either by job or by day. Remember, the statistics are reset
each time you turn the power on to your peripheral, so the
Total option will only display the stitches sewn since the last
time the peripheral was powered up. 

Sort by thread breaks 
When you select this option, the number of thread breaks
(per head and per needle) will be displayed. You can choose
to display the thread breaks either by job or by day.
Remember, the statistics are reset each time you turn the
power on to your peripheral, so the Total option will only
display the total breaks since the last time the peripheral
was powered up. 

Statistical View 
The statistics that can be reported by your peripheral are
displayed here in a table format. The head number (when
appropriate) is displayed across the top, while the needle
number is displayed along the left. This helps to organize
your information. 

To have your statistics sorted differently, click on one of the
radio buttons under the Statistical View area. There are 2
separate sort blocks; the block on the left (Thread Break, for
example) can be displayed according to the block on the
right (for this Job, for example). Choose the sort options you
wish to view. The default sort is Thread Breaks by Job.

32292 Rev. A Melco Embroidery Systems



Embroidery Network System User Manual18

32292 Rev. A Melco Embroidery Systems

Reset 

Click this button to reset the statistics in the machine to
zero. This is a reporting function of the basic statistical
features which are built in to your peripheral. Each time the
power is turned off to the peripheral, the statistics in ENS
are reset, as well. If you want to save the statistical data
prior to a reset, click the save button before selecting Reset.

Save 
Click the Save button to save the current statistical
information. Clicking Save will display the Save As dialog
box, allowing you to specify the location and file name of the
saved information. 

Sort by job 
Allows you to view statistics for the current job. The
statistics are sorted based on the parameter selected to the
left (thread breaks, bobbin breaks, etc.). Remember, the
statistics are reset each time you turn the power on to your
peripheral, so the Total option will only display the total
breaks since the last time the peripheral was powered up. 

Statistics - Total 
Allows you to view statistics total since the last time the
peripheral was turned on. The statistics are sorted based on
the parameter selected to the left (thread breaks, bobbin
breaks, etc.). Remember, the statistics are reset each time
you turn the power on to your peripheral, so the Total
option will only display the total breaks since the last time
the peripheral was powered up. 

Sort by bobbin break 
When you select this option, the number of bobbin breaks
(per head) will be displayed. You can choose to display the
bobbin breaks either by job or by day. Remember, the
statistics are reset each time you turn the power on to your
peripheral, so the Total option will only display the total
breaks since the last time the peripheral was powered up. 

Saving
All information
will be saved in
ASCII text format
(viewable in most
text readers).

Resetting
After clicking the
reset button, a
confirmation box
will be displayed
to confirm the
reset.
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Update 

ENS polls the selected peripheral once per second. However,
if these updates were displayed as they occurred, your
screen would be a flash of numbers. So the way ENS
displays statistical information is similar to the function of a
camera. When you select a peripheral, a snapshot of the
statistics is taken and displayed on your screen. 

To update the snapshot, click on the Update button. This
will display the most current information for the selected
peripheral. 

Status Tab 
The Status tab allows you to quickly review the status of
each peripheral connected to your network. Below is a
picture of the Status tab.

Color Sequence 
These fields cannot be edited. They display the color
sequence currently set in the selected peripheral. 

The left hand column shows the color change number in the
design and the right hand column shows which needle that
color change is assigned to. Use the scroll bar to view all the
color changes for the design. This is an informational screen
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Deleting
Designs You can
free up machine
memory by
deleting designs.
Click on the
design name
then click on the
delete button.

only. You must change the color sequence at the peripheral. 

To view the color sequence on a different peripheral, click on
a peripheral in the peripheral list (along the left-hand side of
the screen). 

Current Design 
This field cannot be edited. It displays the design currently
being sewn on the selected peripheral. 

To view the current design on a different peripheral, click on
a peripheral in the peripheral list (along the left-hand side of
the screen). 

Designs 
This field shows the current designs saved in machine
memory for the selected peripheral. You cannot add designs
to memory from the status tab (you must do that through
the transfer tab). You may, however, delete designs from
memory through this field. 

To delete a design, left click on the design name one time,
then click the delete button. 

To view the designs saved in memory for a different
peripheral, click on a peripheral in the peripheral list (along
the left-hand side of the screen). 

Free RAM 
This field cannot be edited. It displays the amount of free
memory in the selected peripheral (in bytes). To free-up
more machine memory, delete some designs that are stored
in machine memory 

To view the amount of free memory in a different peripheral,
click on a peripheral in the peripheral list (along the left-
hand side of the screen). 

Job Time 
This field cannot be edited. It displays the amount of time
the current design has been running on the selected
peripheral. 
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To view the job time on a different peripheral, click on a
peripheral in the peripheral list (along the left-hand side of
the screen). 

Max RPM 
This field cannot be edited. It displays the maximum RPM
(speed setting) for the selected peripheral. To change this
value, change the current sewing speed at the peripheral. 

To view the Max RPM in a different peripheral, click on a
peripheral in the peripheral list (along the left-hand side of
the screen). 

Print 
Click Print to print the information found on the current
tab. If you select Print from the File Menu, it will print all
the pertinent information from all the tabs. 

When you print to a file, you must first select the printer
that will ultimately print the file. ENS then saves the file in
the appropriate printer language. That printer can be
connected to any kind of computer, even if ENS is not
installed. 

Status (Progress) Bar 
This field cannot be edited. It displays (in a graphical
format) the percent of stitches sewn so far in the current
design for the selected peripheral. 

To view the Progress Bar for a different peripheral, click on a
peripheral in the peripheral list (along the left-hand side of
the screen). 

Stitch Count 
This field cannot be edited. It displays the number of
stitches sewn so far in the current design for the selected
peripheral. 

To view the stitch count on a different peripheral, click on a
peripheral in the peripheral list (along the left-hand side of
the screen). 
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Thread Breaks 
These fields cannot be edited. They display the thread break
history in the selected peripheral. 

The field is divided into 2 main areas: one that shows upper
thread breaks and one that shows bobbin breaks. 

The upper thread breaks are displayed for each needle on
the peripheral. One counter displays the total thread breaks
for the current job (this counter is reset when a new job is
started at the peripheral). The other counter shows the total
thread breaks (this counter is reset when the peripheral is
turned on). 

Bobbin breaks are displayed in the same manner. The job
counter for bobbin breaks is reset when a new job is
started. The total counter for bobbin breaks is reset when
the peripheral is turned off. 

To view the thread break history on a different peripheral,
click on a peripheral in the peripheral list (along the left-
hand side of the screen). 

Transfer Tab 
The Transfer tab allows you to select files to be transferred. 
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Auto Delete 
When Auto Delete is selected, the peripheral will
automatically delete the design from machine memory after
the design has been successfully sewn. 

Auto Queue 
Selecting Auto Queue means the design will be
automatically queued at the peripheral. This option
bypasses having to select the design at the machine. 

File List 
This field displays all the available files (of the selected type)
in the current directory. 

If you click on a file in the file list, a graphical image of the
file (a thumbnail) will automatically appear in the thumbnail
section. 

You can select multiple files in the File List using the SHIFT
key and the CTRL key along with your mouse clicks. The
SHIFT key will select consecutive files in the File List. The
CTRL key will select NON-consecutive files in the File List. 

To select consecutive files: 

1. Left click on the first file. 

2. Hold down the SHIFT key and left click on the last file.
All the files in between will be selected. 

To select NON-consecutive files: 

1. Hold down the CTRL key and left click on a file. 

2. Continue holding down the CTRL key and left click on all
the files you wish to select. 

Once you have selected a file or files, you can send them to
the peripheral in 2 ways. The first option is to click the Send
button. This will send all selected files to the peripheral that
is currently selected in the Peripheral List (along the left-
hand side of the screen). 

The second option is to drag and drop the selected file(s) to
a peripheral in the peripheral list. To do this, simply left

Auto Queue
When selecting
this option, you
may still need to
set your color
sequence at the
peripheral (if it is
different than
your last run)
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click and hold on a file, drag your cursor over one of the
peripherals in the list (any peripheral) and release the left
mouse button. If you have selected multiple files, all files
will be sent to the selected peripheral. 

File Name 
You can type the file name to be sent, in this field. Also, if
you click on a file in the File List, the file name will
automatically appear in this field. 

File Type 
This drop-down field determines what file types will be
displayed in the File List. Click the arrow to display the
available choices. 

To show a particular file type, simply select that type from
the available choices. 

The Expanded (.EXP) file type is the default. 

Look in... 
Use this field to select the drive and directory to select files
from. Click on the arrow to display the drive and directory
structure of your computer. 

Rename As Sent
This is a useful tool to rename the file that you send to a
peripheral. Especially if it is a duplicate file that you have
modified and would like to send to the peripheral after you
have sent it already. Normally when you do this you will get
a message stating that the file already exists in the que of
the peripheral. If you rename it in ENS before sending it,
you will save time by not having to reset the que of designs
on the machine.

A perfect example of when this feature would be very useful
is when you have the same design with numerous names
(lettering) that needs to be added to the design.
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Send 
After you have selected the file and appropriate machine(s),
click the send button to send the file(s) to the peripheral. 

Thumbnail 
The thumbnail is a graphical image of the file you have
selected in the File List. To display the thumbnail for a file,
simply click on that file name in the list. 
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The Menus 
There are 3 menu choices in ENS (excluding Help).

File Menu 
The File Menu contains 2 menu choices: 

Print Setup: If you click on Print Setup, you can configure
your printing options for desired printer, properties, paper
and orientation. 

Exit: If you click on Exit, it will close the ENS program. 

View Menu 
There are 3 menu choices in the View Menu; they are: 

Status Bar: If there is a check mark next to Status Bar, the
status bar will be displayed along the bottom of the ENS
window. The Status Bar displays useful information
pertinent to your current selection. 

Last Alert: If there is a check mark next to Last Alert, the
Last Alert window will be displayed under the peripheral list
(along the left-hand side of the ENS window). The Last Alert
window will display the most recent Alert received from any
peripheral connected to the ENS Network. The Alert will be
displayed until another Alert is received. 

Auto Alert: If there is a check mark next to Auto Alert, a
dialog box will appear in front of the ENS window every time
an Alert is received from any peripheral connected to the
ENS Network. The dialog box is designed to notify you of
each Alert received, and there will be an "Ok" button on the
dialog box; click Ok to acknowledge the Alert and make the
dialog box disappear. 

Print Setup
Refer to Windows
Help for more
information on
printer
configuration.
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Tools Menu 
Unlike the other menu commands, the Tools Menu items
invoke separate dialog boxes to configure various settings in
ENS.

Configure the Network Properties. 

Configure the Security Settings. 

Properties
The Properties tab allows you to quickly configure ENS.
Below is a picture of the Properties dialog box.

StarLAN Properties 
Enable: If you have an EMC peripheral and want to use the
StarLAN portion of the ENS Network, make sure there is a
check in the Enable box. This configures ENS to enable the
StarLAN networking support. 

Settings: In most cases, the default settings will work fine.
Click on Default to accept these settings. If you wish to
customize the settings, select the appropriate values. 

Note: No two pieces of hardware may use the same IRQ or
DMA settings. These instructions for installing the Melco
boards work in most computers sold today without
changing other settings. 
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Ethernet Properties 
Enable: If you have an EMT peripheral and want to use the
Ethernet portion of the ENS Network, make sure there is a
check in the Enable box. This configures ENS to enable the
Ethernet networking support. 

Allow RSA Download: This check box configures ENS to
download RSA files to your peripheral when they are
requested (during the power up sequence). Note: Only one
computer should be responsible for downloading RSA files.
If you are using multiple servers, make sure only one
computer is responsible for downloading RSA files. By doing
this you only have to keep one computer updated.

Server Name: This field allows you to name the server; this
name will appear in the Client/Server Tab shown in ENS.

Alert Properties 

Log 
Save Between Runs: If this box is checked, when you close
ENS all of the alerts in the list will be saved to a file and will
be restored the next time ENS is started. The file is saved as
alerts.dbf and can be viewed in any application capable of
displaying a .dbf file. 

Number to Save: This number specifies the number of alerts
that are written to disk when ENS is closed. If 500 alerts
have accumulated and you specify to save 200, when you
close ENS, the most recent 200 will be saved and the
remainder will be deleted. 

Server Name
If you have
multiple servers,
it is helpful to use
different names
for each (but not
required). 
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Notification 
Flash till Click in Last Alert Box: If this box is checked, the
alert will flash until you click in the Last Alert Box (below
the peripheral list). Or, you can specify the number of times
you wish the Alert to flash. 

System Exclamation Sound when Flash: If this box is
checked, the sound you have configured as the System
Exclamation (you can set this in the Control Panel) will be
played every time an alert is flashed. 
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Security Settings

There are four tabs under the Tools Menu, Security. The
three tabs are General, Levels, Options, and Misc.

The General Tab displays
The Melco Dongles that
are attached to that
particular computer and
the Serial Number
associated with each
dongle.

If you have Design Shop,
the Levels Tab displays the
Current Level of Design
Shop. If upgrading to
another level of Design
Shop, here is where you
will type in the password
for the higher level. The
first level is Design Shop
Lite, which is primarily a
lettering system. The next
Level is Design Shop,
which contains lettering
and editing. The next level
is Design ShopPro, which
contains lettering, editing,
and digitizing. The top
level, Design Shop Pro +, is
the same as Design Shop
Pro, but also provides the
Graphics Converter and
more distortion fills.

32
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The Options Tab displays
the available options for
Design Shop and this is
where you would type the
password for purchased
options.

The Misc. Tab contains
information pertaining to
your dongle.

Delete ASD Files (Back-Up Files)

ASD Files are backup files made by ENS when you send
designs to a peripheral. ENS needs the ASD files in cases
such as a power failure. If the power goes out and you bring
the peripheral up again, ENS will send the ASD file again.
This is particularly useful if you have changed the original
file in the meantime.



ASD files can add up and take quite a bit of space on your
hard drive. It is recommended that you delete the ASD files
from time to time. Once a month might be sufficient
depending on how many designs you send to the peripheral
on a daily basis.

To delete the ASD files, simply click on the Tools Menu,
Delete ASD Files... You will then get a pop-up dialogue
asking if you are sure that you want to delete the ASD files.
Click "Yes". 
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